
HP Service Manager
Software Version: 9.21
For the supported Windows® and Unix® operating systems

 

 

 

 

 

Patch 10 Release Notes

 

Document Release Date: February 2015
Software Release Date: February 2015

 



Legal Notices

Warranty
The only warranties for HP products and services are set forth in the express warranty statements accompanying such products and services. Nothing herein should be 
construed as constituting an additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend
Confidential computer software. Valid license from HP required for possession, use or copying. Consistent with FAR 12.211 and 12.212, Commercial Computer Software, 
Computer Software Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard commercial license.

Copyright Notice
© 1994-2015 Hewlett-Packard Development Company, L.P.

Trademark Notices
Adobe® is a trademark of Adobe Systems Incorporated.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

Oracle and Java are registered trademarks of Oracle and/or its affiliates.

UNIX® is a registered trademark of The Open Group.

Linux® is the registered trademark of Linus Torvalds in the U.S. and other countries.

For a complete list of open source and third party acknowledgements, visit the HP Software Support Online web site and search for the product manual called HP Service 
Manager Open Source and Third Party License Agreements.
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Documentation Updates
The title page of this document contains the following identifying information:

 l Software Version number, which indicates the software version.
 l Document Release Date, which changes each time the document is updated.
 l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go to:           https://softwaresupport.hp.com

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, go to:           http://h20229.www2.hp.com/passport-registration.html

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service. Contact your HP sales representative for details.
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Support
Visit the HP Software Support Online website at: https://softwaresupport.hp.com

This website provides contact information and details about the products, services, and support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and efficient way to access interactive technical support tools needed to manage your 
business. As a valued support customer, you can benefit by using the support website to:

 l Search for knowledge documents of interest
 l Submit and track support cases and enhancement requests
 l Download software patches
 l Manage support contracts
 l Look up HP support contacts
 l Review information about available services
 l Enter into discussions with other software customers
 l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a support contract. To register for an HP Passport ID, go to:

      http://h20229.www2.hp.com/passport-registration.html

To find more information about access levels, go to: 

      http://h20230.www2.hp.com/new_access_levels.jsp

HP Software Solutions Now accesses the HPSW Solution and Integration Portal website. This site enables you to explore HP Product Solutions to meet your business needs, 
includes a full list of Integrations between HP Products, as well as a listing of ITIL Processes. The URL for this website is http://h20230.www2.hp.com/sc/solutions/index.jsp
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This document is an overview of the changes made to HP Service Manager 9.21 for patch 10. It contains 
important information that is not included in other documentation. 
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What's New in This Release
This section describes important changes in this release.

Important:              Based on customer feedback, the overall quality of Service Manager has been an area 
of concern over the last number of years. To that end, the Service Manager R&D team has spent a 
significant amount of effort improving the quality of Service Manager, and recent customer 
feedback is very positive. Many defects that have been in the product for many years are now fixed 
in the SM 9.3x. The issues resolved in this build patch cover only the most critical fixes.  To gain 
better performance and user experience, we strongly recommend that you apply the latest 
binaries from SM 9.3x instead of this build patch.

    In most cases SM 9.3x binaries are compatible with SM 7.1x and SM 9.2x applications. Therefore,  
you are not required to perform a full upgrade to take advantage of the latest Service Manager 
technology.  Specific compatibility details are listed in the SM 9.3x release notes.         

Server parameter: sslProtocols
This parameter enables you to specify the protocols to use when Service Manager clients (Windows, 
web, or web services) are connecting to the server through Secure Socket Layer (SSL) or when the 
Service Manager server is connecting as a client to another application through SSL. 

Note: It provides an option to disable the SSLv3 protocol for Service Manager for security 
considerations (by specifying sslProtocols:TLSv1,TLSv1.1,TLSv1.2).

To specify the protocols for SSL connections, follow these steps:

 1. Add this parameter to the sm.ini file. The parameter value should be a comma-separated list of 
any combinations of the following values: SSLv3, TLSv1, TLSv1.1, and TLSv1.2. The default value is: 
SSLv3,TLSv1,TLSv1.1,TLSv1.2.

For example: 

sslProtocols:TLSv1,TLSv1.1,TLSv1.2
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If this parameter is not present in the sm.ini file, the default value  is used.

 2. Restart the server.

Certifications
This release includes the following support matrix changes.

Added support

 l Firefox 24 and later

Discontinued support

 l Firefox versions 17 through 23

See also the compatibility matrix for Service Manager 9.21 on the HP Software Support Matrices site:  

https://softwaresupport.hp.com/group/softwaresupport/support-matrices
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Enhancements
This release includes the following enhancements.

CR Problem Solution 

QCCR1E98986 Mozilla Firefox 
24 is not 
certified for 
the Service 
Manager web 
client. 

Mozilla Firefox 24 and latest versions are now certified for the 
Service Manager web client. 

Note: By default, Firefox 26 blocks all Java plugins. Therefore, 
when you use the telephony, workflow, or Visualize CI plugins 
with Firefox 26, you are prompted for authorization before the 
plugin starts. Simply click "Allow " to continue. For detailed 
information, refer to its release notes: 
http://www.mozilla.org/en-US/firefox/26.0/releasenotes/ 

QCCR1E99002
       

Firefox versions 
17 to 23 are no 
longer required 
in the support 
matrix 
documentation.
       

Firefox versions 17 to 23 are deleted from the Support Matrix. The 
entry for               Firefox is modified to "Firefox 24 or greater (Extended 
Support Releases are               recommended)."       
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Fixed Defects
This release fixes the following defects.

Server
CR Problem Solution 

QCCR1E70834       The Load Balancer and 
background processes 
unexpectedly terminate in a               
horizontally scaled Service 
Manager environment.       

This "jgroups node got shunned" issue is solved by 
changing the JGROUP               configuration.       

QCCR1E70925       When the views under the 
'group by' feature are 
refreshed or initially displayed,      
       the first group is automatically 
expanded after upgrading to 
Service Manager              7.11.410 
(Patch 17) in the Web client.       

Now the To Do queue groups will not be 
automatically expanded when you switch               between 
queues or views.       

QCCR1E76724       After deleting the unique key of 
cm3r, a signal 11 happened 
while doing an IR regeneration.

This issue occurs because the 
SM server does not check to 
see if a unique key or IR key 
exists before it starts a key 
regeneration, and thus causes a 
signal 11.

The Service Manager server now checks if the 
number of unique keys or IR keys is zero. If yes, 
the server then issues a warning message to the 
client that indicates the IR regen cannot be 
performed without a unique key.     

QCCR1E101263
       

User session crash on saving 
particular datadict record 
(cm3t).       

The "buffer out of bound" Java stream bug is 
fixed.       
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CR Problem Solution 

QCCR1E101528
       

When you try to retrieve the 
probsummary records by using 
a simple query, the               legacy 
connection closes and a "Signal 
11" error is generated.       

You can now retrieve the probsummary records by 
using a simple query as expected.       

QCCR1E101794 In JavaScript, when you assign 
an array variable that is not 
empty to the variable itself and 
then print its value, the value is 
NULL.

Now when you assign an array variable that is not 
empty to the variable itself, the value is not NULL 
any more.

QCCR1E103870 The sort order of a view is lost 
when you refresh the view.

The sort order of a view is retained when you 
refresh the view.

QCCR1E104185
       

The following error is recorded 
in the server log file:        
     JRTE E sendResponse() execute 
failed - Invalid byte 2 of 3-byte 
UTF-8 sequence       

This error is not recorded in the server log file.       

QCCR1E104187
       

The coredump is not generated 
immediately when an exception 
is thrown from a JAVA               part.       

The Java Virtual Machine Tool Interface (JVMTI) is 
now used to monitor the JVM               events. The JVMTI is 
loaded during the initialization of the JVM. When a 
JAVA               exception is thrown, a callback function that 
is registered for the exception               event is called to 
generate a coredump. 

Note: To generate a coredump when a JAVA 
exception is thrown, add the following 
parameters to the server configuration file 
(sm.ini) (take Linux for example):

JVMOption0:-
agentpath:libsm.so=opt1,opt2

CatchMethods:findResourceInternal

ThrowMethods:parse

enablecoredump:1

QCCR1E104624
       

When you save a record, the 
Service Manager client is 
terminated unexpectedly.       

The Service Manager client is not terminated 
unexpectedly when you save a record.       
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CR Problem Solution 

QCCR1E105515
       

When you are creating a new 
change in the Web client, the 
change category and the               first 
subcategory are expanded, and 
the first change type is pre-
selected.       

Now the "change category" group will not be 
expanded until one of its list item               is selected by 
the user. This change also affects those tab 
windows brought up by               "Change management > 
Change Queue" or "Incident management > 
Incident Queue" menu               items.       

QCCR1E105608
       

After you apply Service 
Manager 9.21 Application Patch 
3, some fields are added               as the 
"intType" type in the 
"extaccess" table for some 
objects (such as "Change"               
(name=cm3r)). Therefore, the 
web service no longer works 
correctly until you               remove this 
added entry.       

Now the web service works properly.       

QCCR1E110852
       

The label for the "Apply 
Template" button is partly 
truncated in the Enterprise               
Self-Service (ESS) view.       

The label for the "Apply Template" button is 
displayed completely in ESS view.       

QCCR1E111411
       

Users cannot connect to the 
Service Manager system 
occasionally even though they               
restart the system.       

The memory buffer overflow issue is fixed and the 
system is stable now.       

QCCR1E112126
       

When logging on to Service 
Manager by using the web 
client, the change categories               
are expanded. The first 
subcategory is also expanded 
and the first change type is                pre-
selected.       

Now the first category will not be expanded when 
you click New, Search, or other               buttons on the 
ToDo Queue menu.       
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CR Problem Solution 

QCCR1E115291
       

When you click Knowledge 
Management > Search 
Knowledgebase > KM Doc Id to 
search               for a Knowledge 
Management document, it 
takes a long time 
(approximately 2 to 5               minutes), 
to open the document.        
       The issue occurs for Knowledge 
Management articles that have 
a large number of               attached 
files and for all users including 
Administrator.       

The waiting time to open Knowledge Management 
articles is now acceptable.       

QCCR1E116873
       

The "SCFile.getAttachment" 
JavaScript function does not 
work.       

The "SCFile.getAttachment" JavaScript function 
now works as expected.       

Web Client
CR Problem Solution 

QCCR1E101344
       

A Virtual Join in the Web client displays 
only the first row of the list instead        
       of the full list.       

A Virtual Join in the Web client now 
displays all rows of the list.      

QCCR1E104627
       

If two Text Area controls in two 
different notebook tabs share the same 
input               value, and one of the tabs has a 
DVD visible condition that is evaluated 
to               false, the first line will be the last line 
after the page is refreshed due to a               
form submit action.       

If two Text Area controls in two different 
notebook tabs share the same input               
value, and one of the Tabs has a DVD 
visible condition evaluated to false, the               
content in the Text Area remains 
unchanged after the page is refreshed 
due to a form submit action.       
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Known Problems, Limitations, and Workarounds
The following table lists the known issues discovered in this release.

Global ID Known Issue Workaround

QCCR1E89890 Grouped Views are not correctly updated after 
logging a new incident.

When you log a new incident, to 
keep consistency with actual 
incidents, the group number is 
not updated. 

You need to click the Refresh 
button to update grouped 
Views.

QCCR1E72809 After closing a ticket (such as an Interaction or 
Incident) and returning to the view, the queue is 
not synchronized correctly.

As a workaround, click the 
Refresh button to solve the 
view display issue.

QCCR1E120715 Service Manager 9.21 JavaMail does not support 
SSL/TLS connections on a port that needs to use 
the STARTTLS command (port 25 or 587 of Gmail, 
for example).  

Use the dedicated SMTP 
SSL/TLS port (port 465 of  Gmail, 
for example).
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Documentation Errata
The following documentation item is incorrect. 

Location:

Online help: Help topic "Startup parameter: agstackl"

Error: :    

The default value of this parameter is 400.

Correction:

The default value of this parameter is 600.
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Backout Instructions
If you want to restore your Service Manager system to its original state after installing this patch, follow 
these guidelines.

Server
To backout your server changes, make a backup before installing the patch and then roll back.

Backup

Before applying the server patch, make a backup of the server installation folder. For example, 
C:\Program Files\HP\Service Manager 9.21\Server.

Note: If you have a load balanced system, be sure to back up the server installation folder for every 
server instance respectively.

Backout

To restore your Service Manager server to its original state after installing the patch, do the following:

 1. Stop the Service Manager server.

 2. Remove the existing server installation folder.

 3. Copy the backup folder back.

Note: Make sure that the embedded Tomcat is also replaced with the backup as the version of 
the embedded Tomcat may have dependency with specific server version.

 4. Restart the Service Manager server.

Note: If you have a load balanced system, make sure that every server instance is replaced with its 
respective backup.
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Web Tier
Backup

Before deploying the new web tier, make a backup of the following items:

 l web.xml file

 l application-context.xml

 l splash screen

 l style sheets

 l any other customizations you made, including your webtier-9.21.war (webtier-ear-9.21.ear) file.

Backout

To roll back to the old web tier:

 1. Delete or uninstall the existing web tier.

 2. Clear the cache of your web application server (for example, Tomcat).

 3. Redeploy the old web tier.

 4. Restore your old customizations.

Windows Client
To roll back to your old Windows client, you need to do backup before installing the new Windows client 
and then reinstall the previous Windows client.

Backup

 1. Make a backup of your Windows client home folder, for example, 
C:\Users\<username>\ServiceManager. Your connections and personalized settings are stored 
in this folder.

 2. Make a backup of your security configuration files if any (Window > Preferences > HP Service 
Manager > Security). For example, your CA certificates file and client keystore file.

Backout
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 1. Uninstall the new Windows client.

 2. Reinstall the previous Windows client.

 3. Restore your old Windows connections and configurations.

Applications
Backup

Tip: If your application version is 7.11 ap3, 9.21 ap3, 9.30 ap3, 9.31 or later, you are recommended 
to use Unload Manager to make a backup of the files to be modified by an unload file, because 
Unload Manager can create a backup of your old data during the installation of the unload; if your 
application version is other than any of these, Unload Manager is not available and you can use 
Database Manager instead. 

To use Unload Manager to make a backup:

 1. Go to System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload. A wizard opens.

 3. Select the unload file you want to apply, also specify a backup file, and then click Next.

Details of the unload file appear.

 4. Double-click a conflicting object in the table to open the merge tool:

 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to go back to the wizard.

 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the unload.

 7. Click Finish. 

Now, the unload has been applied and at the same time your old data backed up.

To use Database Manager to make a backup:
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 1. Go to Database Manager, select Import/Load from More or the More Actions menu, and browse to 
the unload file.

 2. Click List Contents on the menu bar, to view a list of files that have been updated in this unload.

See the following figure for an example.

This figure shows the contents of an unload file that contains changes to the following files:

File Record

Process     svc.add.cart

application money.format

Note: The scmessage records listed under each RAD application are 
messages used in this RAD application; no backup is needed for them.

ScriptLibrary svcCartHelper

datadict activity
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File Record

dbdict activity

Note: The “activity” file with no records actually represents the dbdict record 
of the activity file.

scmessage The record whose message class is “fc” and message number is 1000. 

 3. Go to Database Manager, in the Table field enter a file name you got in step 2, and click the Search 
button.

 4. If the format selection page shows, select the proper format by double-clicking it (for example, 
select the device format for the device file), and then search for the file record.

 5. Click More (or the More Actions menu) > Export/Unload after the file record displays.

Note: If Export/Unload is not available, check the Administration Mode check box in Database 
Manager and try again.

 6. In the pop-up window, specify your backup upload file path/name, and click Unload Appl. 

Caution: Make sure that Append to file is selected.

 7. Repeat steps 3 through 6 to back up the rest of the files you got in step 2.

Backout

Tip: You can use Unload Manager (recommended) or Database Manager (if Unload Manager is not 
available in your application version) to roll back to your old data, as described in the following.

To roll back to your old data using Unload Manager:

 1. Go to  System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload.

A wizard opens.
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 3. Select the unload file generated in the backup process, specify a backup file, and then click Next.

Details of the unload file display.

 4. Double-click a conflicting object in the table to open the merge tool:
 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to return to the wizard.

 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the backup unload.

 7. Click Finish.

To roll back to your old data using Database Manager:

 1. Go to Database Manager, click More > Import/Load.

 2. Browse to the backup unload file you created.

 3. Click Load FG.
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Installation Notes
This section provides instructions on installing each component in this patch release.

Digital Signature Notice
HP signs Windows executable files with a digital signature. Since January 2012, this process has been 
updated to use a new VeriSign root certificate. On a Windows system that does not have the new 
VeriSign root or intermediate certificate installed, when the user right-clicks the file and then goes to 
Properties > Digital Signatures > Details, a verification error will display: “The certificate in this 
signature cannot be verified.”

To resolve this issue, either enable Windows Update or download and install the G5 Root certificate as 
documented at: https://knowledge.verisign.com/support/ssl-certificates-
support/index?page=content&actp=CROSSLINK&id=SO19140
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Web Tier Installation
The Web Tier update consists of a compressed file, sm9.21.755-P10_Web_Tier.zip. The specific upgrade 
process depends on your particular Web application server, but follows the same steps as deploying a 
new installation. For more information, refer to the Service Manager Interactive Installation Guide.

The upgrade does not automatically save your Web Tier customizations. To keep your changes, you 
must save your customized files and replace the new version of these files with your customized 
version.

Note: The Service Manager introduces important changes to the Web tier Directory structure since 
SM 9.21 Patch 5 release. For more information on these changes, see the release notes of SM 9.21 
Patch 5 and the “Updates to the Service Manager Web Tier Directory Structure” white paper at the 
HP Software Support Web site: https://softwaresupport.hp.com

To install the new Web Tier:

 1. Make necessary backups. For details, see "Backout Instructions" on page 16.

 2. Delete or uninstall the existing webtier-9.21.war (or the webtier.ear-9.21.ear) file.

 3. Clear the cache of your web application server (for example, Tomcat).

 4. Deploy the new webtier-9.21.war (or the webtier.ear-9.21.ear) file following the instructions in the 
Service Manager Installation Guide.

Note:  

 n It is recommended to enable HTTPOnly cookies in your web application server to help 
prevent malicious JavaScript injection. To  enable HTTPOnly cookies, see Enabling HTTPOnly 
cookies in your Web Application Server.

 n It is best practice to deploy with a unique context root. For example: /webtier-9.21.755

 5. Use a diff utility to compare the new Web tier’s web.xml file against your backed-up version to 
ensure that any new parameters are properly merged into the files used in your final deployment. 
Do this for application-context.xml as well as any other files you may have customized (such 
as style sheets and splash screens).
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 6. Make any new customizations necessary for your deployment.

Note: Be sure to set the securelogin and sslport parameters.

 7. Restart the web application server.

Note: Before accessing the new Web Tier, HP recommends that all users empty their browser 
cache.

Enabling HTTPOnly cookies in your Web Application Server

It is recommended to enable HTTPOnly cookies in your web application server to help prevent malicious 
JavaScript injection. Following are some examples for how to enable HTTPOnly cookies in different web 
application servers:

Web Application 
Server How to Enable  'HTTPOnly' Cookies

Tomcat 6.0.20+ Can be enabled for all web applications in conf/context.xml: 

<Context useHttpOnly="true"> ... </Context>  

Oracle WebLogic  
9.2 MP4, 10.0 MP2, 
and 10.3.1

Enabled by default.

Oracle WebLogic 
10.3.0

You need to apply a security patch (p8176461_103_Generic), and after that 
HttpOnly cookies are enabled by default. The security patch can be downloaded 
using My Oracle Support (MOS). 

JBoss 5.1 Enable by setting useHttpOnly=true in the context.xml file, which is located in 
jboss/server/<myserver>/deploy/jbossweb.sar/.

<Context cookies="true" crossContext="true">
   <SessionCookie secure="true" httpOnly="true" />
       

</Context> 

Patch 10 Release Notes
Installation Notes

HP Service Manager (9.21) Page 24 of 37



Web Application 
Server How to Enable  'HTTPOnly' Cookies

IBM WebSphere  
7.0.0.27

Enable through the following properties:

 l com.ibm.ws.security.addHttpOnlyAttributeToCookies 

 l com.ibm.ws.webcontainer.httpOnlyCookies

Known issue:

If Service Manager 9.21 is deployed on WAS 7.0.0.27, and FireFox is used to 
search "Approved Document" in the Knowledge Management module, you may 
encounter an automatic logout issue.

Follow these steps to fix this issue by removing the incorrect URL for the 
background-image used for the knowledge document:

 1. Log on to the Windows client.

 2. From the Navigation menu, click Knowledge Management > Manage 
Document Types.

 3. Select the Reference record.

 4. Modify the Default View from the Associated Document View view list.

 5. Remove the incorrect URL in the CSS class .documentTitle. For example, 
remove the following: 

url("44ee44677b0f021810318488:kmrtBackground.gif:
 kmattachments:2").

 6. Save the change.

 7. Do the same for the other four records to avoid other similar problems.

IBM WebSphere 
8.0.0.5 

Enabled by default.

Windows Client Installation

Note: In this release, the embedded JRE in the Windows client was upgraded to JRE 7 Update 55.
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The Windows client update consists of a compressed file, sm9.21.755-P10_Windows_Client.zip, which 
contains the executable installation files.

To install the Windows client update:

 1. Stop the Service Manager Windows client.

 2. Make necessary backups. For details, see "Backout Instructions" on page 16.

 3. Uninstall the Service Manager Windows client. (Your connection and personalized settings are 
retained.)

 4. Run setup.exe and install the client by following the instructions in the Service Manager 
Installation Guide.

 5. Check the version in Help > About Service Manager Client.

The client should be Release: 9.21.755.

Windows Client Configuration Utility Installation
Service Manager 9.21p10 includes an updated version of the Windows Client Configuration Utility 
(sm9.21.755-P10_Windows_Client_Configuaration.zip), where the embedded JRE has been upgraded. It 
is intended only for customers who have upgraded their Windows client to version 9.21p10 (or later).

For detailed installation instructions, see the Service Manager 9.20 Installation Guide, which is available 
from the HP Software Support Site: 

https://softwaresupport.hp.com/group/softwaresupport/search-result/-
/facetsearch/document/KM912628

Server Update Installation
The server update for your operating system (OS) consists of a compressed file, sm9.21.755-P10_
<OS>.zip (or .tar), which contains the Service Manager server files. These files add to or replace the 
files in the [SM Server Root]\ ([SM Server Root]/) RUN, irlang, legacyintegration, and 
platform_unloads directories.

Note: If you have a load balanced system, you must upgrade all server instances.
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Caution: This server update will upgrade the embedded Tomcat to version 6.0.36, and therefore 
requires additional steps.

Note: The SM9.21p10 server requires JRE 1.7 (except for Solaris 9).  For Windows and Linux,  the 
embedded JRE has already upgraded to JRE 1.7; for other Unix-based platforms, you need to 
manually perform this JRE upgrade.

The JRE upgrade will cause external web service calls over SSL to fail if the remote endpoint does 
not support Server Name Indication (SNI), which is by default activated in JRE 1.7. Once Service 
Manager is upgraded to use JRE 1.7, it starts to use SNI extensions during the SSL handshake. If the 
remote endpoint does not support SNI, the web service call will fail with an error message. To solve 
this issue, do either of the following: 

 l Activate SNI at the remote end point (recommended)

 l If the remote endpoint does not support SNI extensions, and SNI cannot be activated, add the 
following JVMOption<n> parameter either to the sm.ini file, or to the start command of the 
servlet(s) in the sm.cfg file:

JVMOption2:-Djsse.enableSNIExtension=false

To install the Server update:

 1. Stop all Service Manager clients.

 2. Stop the Service Manager server.

 3. Make a backup of the Server installation directory. See also "Backout Instructions" on page 16.

 4. Delete the RUN/tomcat directory. Tomcat in this directory will be upgraded to version 6.0.36 when 
you extract the server files later.

 5. Delete the RUN/lib directory.

 6. For Windows and Linux platforms, delete the RUN/jre directory. 

Note: This step is required only when you are upgrading from a server version earlier than 
9.21p7. This is to avoid conflicts between the old 1.6-based JRE and new 1.7-based JRE.
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 7. Extract the compressed files for your operating system into the main Service Manager directory on 
the server. The default path is: C:\Program Files\HP\Service Manager 9.21\Server.

 8. For UNIX servers, set the file permissions for all Service Manager files to 755.

 9. For UNIX servers other than Solaris 9, manually upgrade to JRE1.7.

Note: Solaris 9 does not support JRE7. You can run the SM server on Solaris 9 with only JRE 
1.6.0_20 or later.

 a. Install either JDK1.7 or JRE1.7 for your specific platform.

Solaris 10 JRE1.7 (update 15  or greater)

HP-UX JRE1.7 (JRE_7.0.04 or greater)

AIX JRE1.7 (SR4 or greater)

 b. Set your JAVA_HOME environment variable to point to JDK1.7 (if you have JDK1.7 installed) or 
JRE1.7 (if you have only JRE1.7 installed).

 c. Execute \RUN\removeLinks.sh to remove the old symbolic links and then execute 
\RUN\setupLinks.sh to create new symbolic links. 

 d. Run the following command to check that the JRE version is 1.7: 

RUN\jre\bin\java –version

 10. If you have made any customizations/changes to the original RUN/tomcat folder, restore them in 
the new RUN/tomcat folder.

 11. Make sure the server is stopped, and run the sm -unlockdatabase command.

Note: The purpose of this step is to prevent stale license information from being kept in the 
system. In a scaling implementation, you can run this command from any one of your servers.

Caution: This step is required the first time you upgrade to 9.21p6 or later; it is also required 
whenever you change the server’s IP address after your upgrade to 9.21p6 or later.

 12. Restart the Service Manager server.
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 13. Restart the Service Manager clients.

 14. Check the version in Help > About Service Manager Server. The server should be Release: 
9.21.755.

Application Unload Installation
If a platform fix (in most cases, a server fix) also requires an applications change to resolve the relevant 
issue, an unload file is provided. Unload files introduced in earlier patches are also included in this 
cumulative release. If you have not already applied them for a previous patch, you should also apply the 
unload files that are intended for your applications version. For more details about these applications 
updates, see the Release Notes for those patches.

This patch release includes the unload files that come with the server update. When you extract 
sm9.21.755-P10_<OS>.zip (or .tar), it will add the files to the following directory:

[SM Server Root]\platform_unloads ([SM Server Root]/platform_unloads)

Note: Unload files should be installed in their patch order. That is, those introduced in patch 1 
should be applied first, then those introduced in patch 2, and so on. However, unload files 
introduced in the same patch can be installed in a random order, unless otherwise specified.

Unload File Naming Convention
The unload files use the following naming convention: <CR_ID>_SMxxxPxx_SMxxx.unl, where:

 l <CR_ID>: The identification number of the applications defect that the unload file fixes. For example, 
QCCR1E12345. Note that this is always the number of the parent CR of a CR family (if any).

 l SMxxxPxx: The minimum Service Manager patch level that requires the unload file. For example, 
SM921P2, which means the unload file comes with the server updates in Service Manager 9.21 patch 
2 and should be used for patch 2 or higher.

Note: Sometimes this portion contains an additional hot fix number, for example, 
SM711P16HF8. This example means the unload file is intended for Service Manager 7.11 patch 
16 Hot Fix 8 or higher.

 l SMxxx: The Service Manager applications version that requires the unload file. For example, SM711, 
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which means the unload file is intended only for Service Manager applications version 7.11.

Note: If the applications version suffix is omitted, the unload file is then intended for all 
applications versions compatible with the server version, unless otherwise specified. For 
example, for Service Manager server 9.21, the compatible applications versions are 7.11 and 
9.20.

New Application Updates Introduced in This Patch
None.

Application Updates in Previous Patches
The following table lists the unload files introduced in previous patch release.

Unload file

Introduced 
in 9.21 
patch

Used for 
applications 
version(s) Description

QCCR1E29881_
SM921P1.unl

P1 7.11 and 
9.20

Includes application changes to reduce database I/O on 
login.

QCCR1E57766_
SM921P1.unl

P1 7.11 and 
9.20

Includes application changes to reduce jgroups traffic 
on login.

QCCR1E59753_
SM921P2.unl

P2 7.11 and 
9.20

Includes application changes to fix the ToDo bar.

QCCR1E31545_
SM921P2_
SM711.unl

P2 7.11 Prevents backslashes included in a template from 
being duplicated in the output.

Note: This file is not required for Applications 7.00.

QCCR1E31545_
SM921P2_
SM920.unl

P2 9.20 Prevents backslashes included in a template from 
being duplicated in the output.

QCCR1E48580_
SM921P3_
SM711.unl

P3 7.11 Enables translation of Display/Value lists on dynamic 
forms. This is a required fix for the Export to Excel 
redesign.
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Unload file

Introduced 
in 9.21 
patch

Used for 
applications 
version(s) Description

QCCR1E48580_
SM921P3_
SM920.unl

P3 9.20 Enables translation of Display/Value lists on dynamic 
forms. This is a required fix for the Export to Excel 
redesign.

QCCR1E48513_
SM921P3_
SM711.unl

P3 7.11 Lists the records in the right group order when a record 
list is refreshed.

QCCR1E58562_
SM921P3_
SM711.unl

P3 7.11 Includes applications changes for Export to Excel 
redesign.

QCCR1E58562_
SM921P3_
SM920.unl

P3 9.20 Includes applications changes for Export to Excel 
redesign.

QCCR1E67610_
SM921P4.unl

P4 7.11 and 
9.20

Enables you to block potentially dangerous 
attachments.

QCCR1E67072_
SM921P4.unl

P4 7.11 and 
9.20

Enables you to improve the Knowledge Management 
update process (KMUpdate) performance.

QCCR1E67647_
SM921P5.unl

P5 7.11 and 
9.20

Updated the scmessage record from "Doc Engine call 
failed” to include the message number.

QCCR1E70163_
SM921P5_
SM711.unl

P5 7.11 Prevents the KMUpdate process from terminating when 
the Search Engine server is shut down or an indexing 
document error occurs.

QCCR1E70163_
SM921P5_
SM920.unl

P5 9.20 Prevents the KMUpdate process from terminating when 
the Search Engine server is shut down or an indexing 
document error occurs.

QCCR1E71099_
SM921P6_
SM711.unl

P6 7.11 Enables the Value Lists to be displayed instead of the 
data directly retrieved from the database in a QBE list 
when adding a field by using Modify Columns.  

QCCR1E71099_
SM921P6_
SM920.unl

P6 9.20 Enables the Value Lists to be displayed instead of the 
data directly retrieved from the database in a QBE list 
when adding a field by using Modify Columns. 
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Applying Unload Files

Tip: If your application version is 7.11 ap3, 9.21 ap3, 9.30 ap3, 9.31 or later, you are recommended 
to use Unload Manager to load an unload file, because Unload Manager can help you create a 
backup of your old data and reconcile conflicts during the installation of the unload; if your 
application version is other than any of these, Unload Manager is not available and you can use 
Database Manager instead. 

To load an unload file using Unload Manager:

 1. Go to System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload. A wizard opens.

 3. Select the unload file you want to apply, also specify a backup file, and then click Next. Details of 
the unload file appear.

 4. Double-click a conflicting object in the table to open the merge tool:

 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to go back to the wizard.

 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the unload.

 7. Click Finish. 

Now, the unload has been applied and at the same time your old data backed up.

To load an unload file using Database Manager:

 1. Make sure the Windows client is configured for server-side load/unload.

 a. From the Windows client, go to Window > Preferences > HP Service Manager.

 b. Unselect Client Side Load/Unload if is flagged.

 c. Restart the Windows client.

 2. Open Tailoring > Database Manager.

Patch 10 Release Notes
Installation Notes

HP Service Manager (9.21) Page 32 of 37



 3. Right-click the form or open the More Actions menu and select Import/Load.

 4. Browse to the unload file, and view the contents of an unload file before importing it by clicking 
List Contents.

 5. Make a backup copy of all files to be modified by this unload. For detailed steps, see "Backout 
Instructions" on page 16.

 6. Fill in the following fields.

Field Description

File Name Type the name and path of the file to 
load.

Import Descriptor Since unload files do not require an 
Import Descriptor record, leave this field 
blank.

File Type Select the source operating system of 
the unload file.

Messages Option —
All Messages

Select this option to see all messages 
that Service Manager generates loading 
the file.

Messages Option — Totals 
Only

Select this option to see only the total 
number of files Service Manager loads.

Messages Option — None Select this option to hide all messages 
that Service Manager generates when 
loading the file.

 7. Click Load FG.

ODBC Driver Update Installation

Note: This release does not contain any ODBC Driver update. The latest ODBC Driver patch has been 
shipped with the SM9.21p6 release, which you can download from the following site:

https://softwaresupport.hp.com/group/softwaresupport/search-result/-
/facetsearch/document/KM00234051
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The ODBC Driver update contains the following updated files:

 l Scodbc32.dll

 l sci18n.dll

 l sccl32.dll

To install the ODBC Driver update:

 1. Extract the files to your ODBC Driver installation folder, for example: C:\Program 
Files\Peregrine Systems\ServiceCenter 6.2\ODBC Driver.

 2. When prompted, replace the three old DLL files with the new ones.

Knowledge Management Import Utility Update 
Installation

Note: This release does not contain any Knowledge Management update. The latest Knowledge 
Management Import Utility patch has been shipped with the SM9.21p7 release, which you can 
download from: 

https://softwaresupport.hp.com/group/softwaresupport/search-result/-
/facetsearch/document/KM00438944

To install the knowledge Management Import Utility Update:

 1. Extract km-import-9.21.zip in the Knowledge Management package (sm9.21.624-P7_KM.zip) 
to a local drive.

 2. For detailed instructions on the use of the import utility, see the README file packaged in the km-
import-9.21.zip file.
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Service Manager Verified Environments
The Compatibility Matrix lists supported versions of operating systems, browsers, HP Software 
products, and other compatibility and support information.

Note: Most of the support areas require that you register as an HP Passport user and sign in. Many also 
require an active support contract. To find more information about support access levels, go to      Access 
levels.

To register for an HP Passport ID, go to      HP Passport Registration.

To access the Compatibility Matrix:

 1. Use a browser to navigate to the Software Support Online (SSO) web page:

https://softwaresupport.hp.com/group/softwaresupport/support-matrices

 2. Log on with your Customer ID and password or your HP Passport sign-in.

 3. Navigate to the applicable information.
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Local Language Support
UTF-8 is part of the Unicode standard, which enables you to encode text in practically any script and 
language. Service Manager 9.21 supports UTF-8 as an encoding method for new or existing data. It can 
support multiple languages that adhere to the Unicode standard on the same server.

Service Manager 9.21 or later does not provide language packs. A language pack of Service Manager 
9.20 is available for each of the following languages: Japanese, French, Italian, German, Spanish, Korean, 
Russian, Brazilian Portuguese (UI only), Dutch (UI only), Polish (UI only), Czech (UI only), Hungarian (UI 
only), and Simplified Chinese.

Service Manager 9.21 or later can only work with Service Request Catalog (SRC) 1.20, which is English 
only.
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